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Introduction

The Altova® European Banking Authority (EBA) XBRL add-in for Excel enables your organization to
prepare XBRL (eXtensible Business Reporting Language) reports conformant with the EBA (European Banking
Authority) XBRL taxonomy, or with related country-specific XBRL taxonomies.

The Altova® European Banking Authority (EBA) XBRL add-in for Excel enables preparers of XBRL
supervisory reports to do the following:
·
·
·
·

Enter XBRL data in Microsoft Excel, using a predefined template spreadsheet which maps to the XBRL
taxonomy.
Validate the report data directly from Excel, to ensure it conforms to the XBRL taxonomy.
Export report data from Excel to XBRL format.
Import data from existing XBRL reports into Excel.

The Altova® European Banking Authority (EBA) XBRL add-in for Excel supports the EBA XBRL
Taxonomy (starting with version 2.0 up to the most recent version), and country-specific taxonomies. The
supported country-specific taxonomies are as follows:
·
·
·
·
·
·
·
·

Banque de France (ACPR) COREP SUBCON - COREP, SubConsolidated (Prudential scope)
Banque de France (ACPR) LCB FT
Banco de Portugal (BdP) Reporting Framework
Banco de Portugal (BdP) FINREP ITS
Bank of England (BOE) Banking Taxonomy
Bank of England (BOE) Banking Statistics Taxonomy
Deutsche Bundesbank (BBK)
De Nederlandsche Bank Financieel Toetsingskader (DNB FTK)

© 2015-2021 Altova Gmb H
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·
·
·
·
·

National Bank of Belgium (NBB) FINREP (Financial Reporting)
National Bank of Belgium (NBB) TREP (Trading Reporting)
Single Resolution Board (SRB) LTD (Liability Data Template)
Single Resolution Board (SRB) RES
Single Resolution Board (SRB) SRF

Notes:
·

·

The list of supported XBRL taxonomies is periodically updated to include newer versions, independently
of Altova add-in releases. To view or install the latest XBRL taxonomy versions, use the XBRL
Taxonomy Manager 35 tool included with the add-in.
The country-specific XBRL taxonomies are not installed by default when you install the add-in. The
same applies to the older versions of the EBA XBRL taxonomy. You can view, install, upgrade, or
uninstall such taxonomies on demand, using the XBRL Taxonomy Manager 35 .

This documentation should be read in conjunction with the supporting documents included with the EBA XBRL
Taxonomy, such as:
·
·
·

"Description of DPM formal model"
"EBA Architecture for XBRL representation of DPM"
"EBA XBRL Filing Rules"

Last updated: 25 February 2021
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System Requirements

To install and run the add-in, the following system requirements apply:
·
·
·
·

Windows 7 SP1 with Platform Update, Windows 8, Windows 10, Windows Server 2008 R2 SP1 with
Platform Update or newer
Microsoft Excel 2019, 2016, 2013, 2010
.NET Framework 4.0 or later
If you use Excel 2010, Visual Studio 2010 Tools for Office Runtime (https://www.microsoft.com/enus/download/details.aspx?id=48217) must be installed.

Also, note the following important points:
·

·

The add-in is available for both Microsoft Excel 32-bit and 64-bit. Microsoft Excel 64-bit is
recommended if you need to load big taxonomies such as COREP CON, COREP IND, FINREP.
Otherwise, you may see "out of memory" errors when attempting to load such taxonomies with
Microsoft Excel 32-bit.
The add-in requires full access to the Excel document in order to create, validate, and export XBRL
reports. If your organization enforces Information Rights Management (IRM) using the Azure Information
Protection or a similar technology, the latter may restrict access to the Excel document, and thus
prevent the add-in from working. For information about how to permit code to run behind documents
with restricted permissions, see https://docs.microsoft.com/en-us/visualstudio/vsto/how-to-permitcode-to-run-behind-documents-with-restricted-permissions?view=vs-2019.

© 2015-2021 Altova Gmb H
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Installation and Licensing

To install the Altova® European Banking Authority (EBA) XBRL add-in for Excel, download the executable
from the Altova Download Center (https://www.altova.com/download) and run it. Follow the wizard steps to
complete the installation. You will need to accept the license agreement and privacy policy in order to proceed
with the installation.

Make sure to download the executable corresponding to your operating system's and Excel platform (32bit or 64-bit) The 32-bit executable can be installed on both 32-bit and 64-bit Windows; however, it supports
only Excel 32-bit. Note that If you have Excel 32-bit and install the 64-bit version of the add-in, you will still
be running the 32-bit version.

After installation, a new tab called EBA becomes available in the Excel ribbon.

Licensing
To use Altova® European Banking Authority (EBA) XBRL add-in for Excel, you need a valid license key
code. To purchase a new key code, or request a free evaluation from the Altova website, take the following
steps:
1.
2.

In the Excel ribbon, click the EBA tab.
Click Add-In Activation.

A dialog box appears with instructions for getting a new license from Altova, or managing an existing
license.
After you purchase a license from Altova, follow the same steps as above to open the activation dialog box and
upload the license file.
Alternatively, you can upload purchased licenses to an Altova LicenseServer running on your organization's
network. Altova LicenseServer is a free product that helps organizations manage all Altova licenses in a
centralized place. For more information about LicenseServer, see https://www.altova.com/licenseserver.

Altova® EBA add-in for Excel, version 2021r2 Basic Edition
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.

How to view the current version of the add-in
1.
2.

In the Excel ribbon, click the EBA tab.
Click About EBA Add-In.

© 2015-2021 Altova Gmb H
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Installing XBRL Taxonomies

When you install the add-in for the first time on your computer, only the most recent version of the EBA XBRL
Taxonomy is installed by default.
If you need support for other EBA XBRL Taxonomy versions, or country-specific XBRL taxonomies, these have
to be installed separately. Specifically, you can install, upgrade, or uninstall XBRL taxonomies on demand,
using the XBRL Taxonomy Manager 35 tool included with the add-in.
To run the XBRL Taxonomy Manager, do one of the following:
·
·

·

In the EBA ribbon, click Manage Taxonomies.
Run (double-click) a file with .altova_taxonomies extension downloaded from the Altova website. To
open the XBRL Taxonomy Download Center in your browser, select the EBA ribbon, and then click
Altova on the Web > Taxonomy Download.
From the Windows Control Panel, right-click the Altova Taxonomy Manager entry and select
Change or Uninstall from the context menu.

In addition, the check box Invoke Altova Taxonomy Manager is available on the last page of the installation
wizard, after you complete the installation of Altova® European Banking Authority (EBA) XBRL add-in for Excel.
Note the following:
·
·
·

Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect for all users accounts
on the same computer.
Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect in all Altova XBRLenabled applications installed on the same computer.
If the current taxonomy has dependencies on other taxonomies, the dependent taxonomies are also
installed (or uninstalled, as applicable).

For further information, see Managing XBRL Taxonomies
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Creating a New Report

The instructions below show you how to prepare a new XBRL report based on the default EBA (European
Banking Authority) taxonomy available in Altova® European Banking Authority (EBA) XBRL add-in for
Excel. This XBRL taxonomy is installed by default on your computer when you install the add-in. Additional
taxonomies can be installed separately, see Installing XBRL Taxonomies.

To create a new report:
1.
2.

In the Excel ribbon, click the EBA tab.
Click Insert New Report.

3.

Select the taxonomy entry point corresponding to the report that you wish to create. Use the filter at
the top of the dialog box to filter entry points by keywords such as "IFRS", "Funding", and so on. Note
that, by default, only the most current entry points for the current version of the add-in are shown. To
show all the XBRL taxonomies available for download, select the Show entry points available for
download check box. To show all versions, clear the Show only most current entry points check
box.

© 2015-2021 Altova Gmb H
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Entry points that are shown in brick red color are not installed. To install the respective XBRL
taxonomies, select the entry point, and then click OK. This opens the XBRL Taxonomy Manager,
35
where you can complete the installation, see Managing XBRL Taxonomies
.
Because of memory requirements, some entry points cannot be loaded in the 32-bit version of the
add-in, in which case they appear as grayed out on the dialog box above. To make loading of such
entry points possible, use Excel 64-bit and install the 64-bit version of the add-in.
4.

Be patient while the report tables are loaded into Excel. During this operation, a dialog box informs you
of the progress, for example:

Altova® EBA add-in for Excel, version 2021r2 Basic Edition
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Once the report tables have finished loading, notice the Tables section in the EBA Filing Pane.
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5.

Select the check boxes next to tables that you want to include in the report. Notice that each included
table appears on a new sheet in the Excel book.

You can now start entering data in tables, validate it, and export it to XBRL format. See the following topics for
more information:
·
·
·
·

17

Entering Data
Controlling Accuracy of Cells
29
Validating Data
32
Exporting Data to XBRL

26

EBA Filing Pane
EBA Filing Pane is the area where you can include or exclude tables from the report, view information about
each cell, and view or set various report properties. By default, this pane is visible; you can show or hide it by
clicking Toggle EBA Filing Pane command in the ribbon. As illustrated above, the EBA Filing Pane consists
of two main sections: Properties and Tables.

Altova® EBA add-in for Excel, version 2021r2 Basic Edition
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Properties
The properties displayed in the EBA Filing Pane directly affect the content of the XBRL instance file that will
be created when you export the XBRL instance. To view what each property does, click it and observe the
description displayed in the gray box under the grid. Properties that are grayed out are read-only; otherwise,
you can edit a property by typing text or selecting a value as applicable.

The Scheme and Identifier properties under "Reporting Entity" are typically provided by the relevant
competent authorities.
Also note that, even though some property values begin with "http" (for example, Entry Point URI,
Scheme), they do not necessarily point to live web resources and thus should not be considered dead
links. To resolve entry point URIs, the add-in uses a catalog mechanism that maps URIs to files on the
local system. This is in large part due to the size of the taxonomies and the fact that they contain
thousands of files. Accessing the taxonomy files over the Internet would result in extremely slow
performance, even if their issuing organizations served them that way.

Properties are grouped into the following three tabs:
·
·

·

Report - This tab displays properties applicable to the entire report (one report corresponds to one
Excel workbook).
Table - This tab displays only properties of the currently selected table. A table normally corresponds
to a single Excel worksheet. Therefore, whenever you click inside a new Excel sheet, the properties
are re-drawn to reflect the new worksheet.
Cell - This tab displays only properties of the currently selected cell. Whenever you click a new cell,
the cell properties are re-drawn accordingly.

You can set the accuracy-related properties at report, table, or cell level. For more information, see Controlling
26
Accuracy of Cells
.

Tables
To include a table in the report at any time, select its corresponding check box in the EBA Filing Pane. Each
included table appears on a new sheet in the Excel book. To go to a specific sheet, either navigate to it using
the standard Excel way, or click the corresponding table in the EBA Filing Pane. To remove a particular table
from the report, clear the check box next to it. Tables that are not selected will not be included in the report.
Some tables support a Z-Axis (a third dimension). For information about adding a Z-Axis to a table, see
22
Entering Data into Three-Dimensional Tables (Z-Axis)
.
Each report table displayed in the EBA Filing Pane is XBRL-bound, meaning that data you enter directly in the
32
table cells will be reflected in the XBRL instance file when the report is ready, see Exporting Data to XBRL
.
While the report data is work in progress, you can save the Excel workbook and reopen it at any time later, just
like a standard Excel workbook.

Any sheets that contain tables are bound to the XBRL taxonomy, so they must not be deleted. It is also
not recommended to rename such sheets. If necessary, you can add new sheets to the workbook;
however, such sheets would not be bound to the XBRL taxonomy and consequently be ignored when you

© 2015-2021 Altova Gmb H
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generate the XBRL instance file.
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Entering Data

You can populate a report with data either by entering data into cells manually or by pasting values. With some
cells, you can select a value from a predefined list (such as countries or currencies). Also, in some report
tables, you may need to add new rows or columns. The following is a list of tips and best practices for entering
data.

Editable versus non-editable cells
As a general rule, gray cells must not be edited. Only cells that are included in the XBRL-bound area (delimited
by the table boundaries) are to be edited. For guidance with respect to the purpose of the cell, and data
expected to be entered, consult the cell information (properties) displayed in the EBA Filing Pane, in the Cell
tab.

Pasting data
If you paste data from multiple columns, the number of pasted columns should correspond to the number of
columns in the predefined sheet. If you accidentally paste a larger number of columns, or if you type text
outside the default table, unwanted columns may appear outside the XBRL-bound area. To delete unwanted
columns, right-click the cell and select Delete > Table Columns. To prevent Excel from adding new columns
and rows automatically, go to File > Options > Proofing > AutoCorrect Options > AutoFormat As You
Type > Apply as you work, and click to clear the Include new rows and columns in table check box.
When pasting data, it is recommended to keep only the values (and not the formatting). Namely, select the
Paste Values option when pasting cells or rows.

Actual versus displayed cell value
While generating the XBRL instance file, the add-in ignores any cell formatting information and exports the
actual value of the Excel cell. However, bear in mind that, as part of Excel functionality, the actual value may
be different from the value displayed in the cell, because of the cell formatting information. You can view at any
time the actual value (the one that will be written to the XBRL instance) in the formula bar of Excel. Consider
this example:

In the example above, the value that will be written to the XBRL instance is 12345. Note that the number
accuracy reported in the XBRL instance file also depends on the value you selected for the "Accuracy"

© 2015-2021 Altova Gmb H
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properties (see Controlling Accuracy of Cells

Entering Data
26

).

Enumeration values
Some cells expect a fixed predetermined value (for example, cells that represent currencies or countries). In
this case, the add-in displays a small tooltip when you click the cell. You can pick up the required value from
the drop-down list:

To view the full list of all possible values, click the cell and observe the cell properties in the Cell tab of the EBA
Filing Pane.

Conditional cells
In some tables, you must first fill out a cell value in order to make other cells of the table editable. For example,
in the table below, the cell F3 must be first be filled out before all other cells in the same column become
editable.

Altova® EBA add-in for Excel, version 2021r2 Basic Edition

© 2015-2021 Altova Gmb H

Creating a New Report

Entering Data

19

Cells with multiple values
Depending on the XBRL taxonomy, some reports might have facts that represent an arbitrary list of commaseparated multiple values. Consequently, in Excel, the corresponding cell also requires multiple values to be
entered in the same cell.
To enter data for such cells, first expand the drop-down list, and then click all items that qualify.

© 2015-2021 Altova Gmb H
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Entering Data

Alternatively, you can type all the numeric values, separated by a comma, as shown below. Remember that
you can view all possible values of a cell in the Cell tab of the EBA FilingPane.

After you exit a multi-valued cell, it is automatically re-drawn to display all selected values in a readable form
(even though you may have entered only numbers).

Adding new rows
With some tables, you may need to create new rows. For example, this is the case for table "C 10.02"
available through the entry point EBA 2.6 COREP CON. You can add new rows either using the standard Excel
commands or shortcuts, or by clicking the Add Row button in the ribbon. For example, to add a new row to
the table "C 10.02" of the entry point mentioned above, do one of the following:
·
·
·

In the Excel ribbon, click the EBA tab, and then click Add Row | Insert Row Below. Note that the
commands to insert or delete rows are enabled only if the table supports adding new rows.
Click the rightmost cell of the last row in the table, and press Tab.
Right-click a cell in the empty row, and select Insert | Table Row Below from the context menu.

Altova® EBA add-in for Excel, version 2021r2 Basic Edition
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Any newly added rows must be within the XBRL-bound area of the table, clearly delimited by black

Adding new columns
Some tables may need extra columns to be added. In other words, they can grow horizontally. You can add
new columns to such tables in one of the following ways:
·
·

In the Excel ribbon, click the EBA tab, and then click Add Column. Note that this command is
enabled only if the table supports adding new columns according to the XBRL taxonomy.
Click the Add button that appears next to the rightmost column of a table.

·

Right-click a table cell, and then select Insert | Table Columns to the Right from the context menu.

© 2015-2021 Altova Gmb H
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Entering Data into Three-Dimensional Tables (Z-Axis)

Most of the report tables have only two dimensions: the x-Axis (columns) and the y-Axis (rows). However, there
are some tables where you may need to enter data into a third dimension (the z-Axis). An example of such a
table is the "F 34.00.c (AE CON)" table available through the entry point AE CON: Asset Encumbrance,
Consolidated. This table may need an additional sheet for each currency. As shown below, cell F3 is a dropdown list from where you can select a currency.

In cases such as the one above, you can add a new sheet along the z-Axis (third dimension) of the table, as
follows:
1.
2.

In the Excel ribbon, click the EBA tab.
Click the Add Sheet (z-Axis) button. Note that the commands to insert or delete new z-Axis sheets
are enabled only if the table supports adding a z-Axis.

Alternatively, right-click the table in the EBA Filing Pane and select Add New Sheet (z-Axis) from the
context menu, for example:
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This creates a new sheet that displays the third dimension of the table (z-Axis). The sheet representing the zAxis always has an indicative name that resembles the original table. In this example, if you select "Euro" as
currency, the new sheet is called "F 34.00c (EUR).

Data from the third dimension (z-Axis) of a table are displayed as new sheets in Excel. Therefore, threedimensional tables span across more than one sheet. This is an exception to the rule that one Excel sheet
corresponds to one table in the XBRL report. In the XBRL instance, data that belongs to the z-Axis will be,
however, correctly reported as part of the same table.

When you click a cell that represents z-Axis, all the possible values for the drop-down list are displayed in the
Cell tab of the EBA Filing Pane, for example:

© 2015-2021 Altova Gmb H
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Deleting z-Axis sheets
You can delete sheets that contain data from the third dimension (z-Axis) in more than one way.
1.
2.

Select the required sheet (or click the corresponding entry in the "Tables" section of EBA Filing
Pane).
Do one of the following:
· In the EBA tab, click Remove Sheet (z-Axis), or
· Right-click the table in the EBA Filing Pane and select Remove Sheet (z-Axis) from the context
menu.
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Controlling Accuracy of Cells

The accuracy of monetary and other numeric values in the XBRL report can be controlled by setting the
following report properties:
1.
2.
3.

Accuracy of monetary cells
Accuracy of numeric cells
Accuracy of percentage cells

These properties are available in the EBA Filing Pane, in the Properties group.

The property Accuracy of Monetary Cells applies to numeric cells in the report that represent a monetary
value. For example, if you select entry point FP IND: Funding Plans, Individual, Table "P 01.03", this
property affects all cells of type monetaryItemType.
The property Accuracy of Numeric Cells applies to numeric values that have no unit (excluding percentage
values, which have their own data type). For example, if you select entry point SPB CON, Table "C 101.00",
this property affects the column "Maturity (160)".
The property Accuracy of Percentage Cells applies to values that represent a percentage. For example, if
you select entry point FP IND: Funding Plans, Individual, Table "P 01.03", this property affects all cells of
type percentItemType.
To view the type of a cell, first select a cell, and then click the Cell tab in the EBA Filing Pane and observe
the Type property, for example:
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The accuracy you select from the EBA Filing Pane controls the accuracy that will be written for this fact in the
XBRL instance file. More specifically, the "Accuracy" properties are bound to the decimals attribute in the
XBRL instance file. For example, in the image below, the accuracy value indicated in the brackets corresponds
to the value of the decimals attribute in the XBRL instance file.

By default, accuracy is set as follows:

© 2015-2021 Altova Gmb H
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Controlling Accuracy of Cells

The Accuracy of Monetary Cells is set to Cents (2), which sets the value of the decimals attribute in
the XBRL instance to "2"
The Accuracy of Percentage Cells is set to Basis Points (4), which sets the value of the decimals
attribute in the XBRL instance to "4".
The Accuracy of Numeric Cells is set to Exact (INF), which sets the value of the decimals attribute
in the XBRL instance to "INF".

You can set the accuracy-related properties at report, table, or cell level (see the corresponding tabs in the
image above). If you set accuracy at multiple levels, keep in mind that the more specific property always
overrides the more generic one. For example, the accuracy set at cell level takes priority over the one set
at table level. Likewise, the accuracy set at table level takes priority over the one set at report level.

For monetary and numeric cells, the accuracy value can be either positive or negative.
A positive value N specifies the accuracy of up to N digits to the right of the decimal place. For example, the
value 2 specifies the accuracy to be in cents, while the value 3 specifies the accuracy to be up to mills.
A negative value N specifies the accuracy of up to N digits to the left of the decimal place. For example, the
value -3 specifies the accuracy to be up to thousands, while the value -6 specifies the accuracy to be up to
millions.
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Common Tasks
Validating Data

Validation ensures that the XBRL data you are filing conforms to the XBRL specification. The report data should
be validated before you export it to XBRL. You might also want to validate data progressively, after each action
that could potentially render it invalid (for example, after pasting new rows into the spreadsheet).
To validate data, click the Validate button in the EBA tab of the Excel ribbon.

Be patient while Altova® European Banking Authority (EBA) XBRL add-in for Excel performs the validation
process. To validate XBRL data, the add-in creates a temporary in-memory XBRL instance. When validation of
the in-memory instance completes, a validation report similar to the one below is displayed.

The validation result can be any of the following:
Message type

Meaning
The instance data is valid.
The instance data is valid, but has inconsistencies or warnings.
The instance data is not valid.

The Validation Report dialog box may additionally display any of the following message types: information
messages, warnings, and errors.
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Message type

Validating Data

Meaning
Denotes an information message. Information messages do not make the XBRL instance
invalid.
Denotes a warning message, or an inconsistency. Warnings and inconsistencies do not
make the XBRL instance invalid.
Denotes an error. If there are validation errors, the XBRL instance is not valid, and you will
need to edit the report data so as to resolve each error before proceeding with the export
to XBRL.
Note: During validation, the add-in checks XBRL formula assertions and reports them as
errors. If you are using the Altova RaptorXML+XBRL Server for validation
(https://www.altova.com/raptorxml), XBRL formula assertions may be optionally
configured not to be reported as errors.

Note:

By default, the add-in treats invalid cell values as errors. If necessary, you can configure the add-in to
treat invalid cell values as warnings instead, see Settings 56 .

When a report fails successful validation, the Validation Report window may display links to the cell where the
error originates. To quickly find a cell where the error originates, click the underlined text and the cursor will be
positioned automatically on the required cell. Note that there are cases where multiple cells are involved in a
single validation check; in such cases, clicking on the error link will select just one of the affected cells.

To copy the contents of the validation report to clipboard:
·

Click
Copy, and then paste into a target file (for example, an email). Alternatively, right-click inside
the Validation Report window and select Copy All Messages from the context menu.

To save the validation report as text or HTML:
·

Click
Save. Alternatively, right-click inside the Validation Report window and select Save
Validation Report from the context menu.
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To clear the validation report:
·

Click
Clear. Alternatively, right-click inside the Validation Report window and select Clear from
the context menu.
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Common Tasks

Exporting Data to XBRL

Exporting Data to XBRL

Once your report is ready and valid (see Validating Data
this, click the EBA tab, and then click Export to XBRL.

29

), you can generate the XBRL instance file. To do

By default, instance files are saved as files with .xbrl extension. If you need the exported file to have another
extension (for example, .xml), type the file extension in the Export dialog box.
While the XBRL instance is being created, a dialog box which informs you about the progress may be
displayed for a short time.
During the export operation, data is automatically validated. Any errors, inconsistencies and warnings are
reported on the screen after the export finishes.

Note:

Cell values that are not valid (that is, cells that don't conform to the data type of the underlying XBRL
concept) prevent the report from being exported.

For tips on how to avoid data formatting errors, see Entering Data 17 . Note, however, that not all XBRL
validation errors might be related to incorrect formatting. Some errors might occur because entered data does
not meet the XBRL validation rules applicable to the report you are filing.
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Importing Data from XBRL

You can import data from existing instances of XBRL reports into Excel (typically, files with .xbrl extension).
For the import to be successful, the imported instances must be valid XBRL reports. They may be either
reports you have previously generated using the Altova® European Banking Authority (EBA) XBRL add-in
for Excel, or reports that you received from other parties.

To import an existing XBRL instance file into Excel:
1.
2.
Note:

In the Excel ribbon, click the EBA tab.
Click Import from XBRL, and browse for the XBRL instance file.
If a report is already open in Excel, the Import from XBRL button is disabled. To enable the
command, save and close the current report (workbook) and create a new workbook.

During the import operation, a dialog box informs you about the progress:

While the report data is loaded into Excel, it is automatically validated. A dialog box notifies you about potential
warnings, inconsistencies, or errors (see also Validating Data 29 ).
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During import, the add-in validates XBRL formula assertions. A report will be imported even if it contains
unsatisfied assertions.
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Managing XBRL Taxonomies

XBRL Taxonomy Manager is a tool that provides a centralized way to install and manage XBRL taxonomies for
use across all Altova XBRL-enabled applications, including Altova® European Banking Authority (EBA) XBRL
add-in for Excel. On Windows, XBRL Taxonomy Manager has a graphical user interface and is also available at
the command line. On Linux and Mac*, the tool is available at the command line only.

* The Linux and macOS operating systems are applicable only if you are running XBRL Taxonomy
Manager on those operating systems in conjunction with Altova cross-platform server applications such as
MapForce Server, StyleVision Server, or RaptorXML+XBRL Server.

XBRL Taxonomy Manager provides the following features:
·
·

·
·

·

View XBRL taxonomies installed on your computer, and check whether new versions are available for
download.
Download newer versions of XBRL taxonomies independently of the Altova product release cycle. All
taxonomies are maintained by Altova on an online-based storage accessible to XBRL Taxonomy
Manager, and you can download them as soon as they become available.
Install or uninstall any of the multiple versions of a given taxonomy (or all versions if necessary).
A single XBRL taxonomy represents a "package" but it may have dependencies on other taxonomies.
Whenever you choose to install or uninstall a particular taxonomy, any dependent taxonomies are
detected and also installed or removed automatically. The graphical user interface (or the command
line if applicable) informs you when dependencies are being added or removed.
XBRL taxonomies maintained through XBRL Taxonomy Manager benefit from the XML catalog
mechanism that enables URI references in instance or schema documents to be resolved from local
files, as opposed to being retrieved from the Internet. This is extremely important in the case of big
XBRL taxonomies where schema resolution from remote URIs is not practical or even recommended,
mainly for performance reasons.

XBRL Taxonomy Manager provides a way to administer any of the XBRL taxonomies required for use in any
one of the Altova XBRL-enabled applications 35 . These include the European Banking Authority Reporting
Framework taxonomies, US-GAAP Financial Reporting taxonomies, and various other country- or domainspecific XBRL taxonomies. To view the full list, either run XBRL Taxonomy Manager or run the list command
at the command line.

Altova XBRL-enabled applications
The following Altova applications are XBRL-enabled and thus benefit from the features provided by XBRL
Taxonomy Manager:
·
·
·
·
·
·
·
·

Altova XBRL Add-ins for Excel (EBA, Solvency II)
MapForce Enterprise Edition
MapForce Server
MapForce Server Advanced Edition
RaptorXML+XBRL Server
StyleVision Server
StyleVision Enterprise Edition
XMLSpy Enterprise Edition
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Changes in XBRL taxonomies using XBRL Taxonomy Manager take effect for all the applications listed
above if they are installed on the same computer.

Installation
XBRL Taxonomy Manager is installed automatically whenever you install any Altova XBRL-enabled application
or the Altova Mission Kit Enterprise Edition. Likewise, it is removed automatically when you uninstall the
last Altova XBRL-enabled application from your computer or the Altova Mission Kit Enterprise Edition.

How it works
Altova maintains an online taxonomy storage where all XBRL taxonomies used in Altova products are stored.
This taxonomy storage is updated on a periodical basis, for example, shortly after new versions of relevant
taxonomies are released by their issuing organizations.
Whenever you run XBRL Taxonomy Manager at the graphical user interface, information about the latest
available taxonomies is displayed in a dialog box, where you can view, install, upgrade or uninstall them. You
can also perform the same actions at the command line interface.
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You may also install taxonomies by running .altova_taxonomies files downloaded from the Altova website
(https://www.altova.com/taxonomy-manager).
Regardless of the manner in which taxonomies were installed, all information about installed taxonomies is
tracked in a centralized location on your computer, also known as the local cache directory. The local cache
directory contains information about Altova packages (except for the actual taxonomy files, which are installed
on demand). The local cache directory is at the following path:
Linux

/var/opt/Altova/pkgs

macOS

/var/Altova/pkgs
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Windows

C:\ProgramData\Altova\pkgs

The local cache directory gets updated automatically from time to time, so as to propagate the latest state of
the online storage to the local computer. More specifically, the cache is updated as follows:
·
·
·
·

When you run 39 the XBRL Taxonomy Manager.
When you run Altova® European Banking Authority (EBA) XBRL add-in for Excel for the first time in
the same calendar day.
If Altova® European Banking Authority (EBA) XBRL add-in for Excel is already running, the cache
directory gets updated every 24 hours.
You can also update the local cache from the online storage on demand, by running the update
command at the command line interface.

As you install or uninstall taxonomies, the local cache directory gets automatically updated with information
about the available and installed taxonomies, as well as the taxonomy files themselves.

The local cache directory is maintained automatically based on the taxonomies you install or uninstall; it
should not be altered or deleted manually. If you ever need to reset XBRL Taxonomy Manager to the
original "pristine" state, run the reset command of the command line interface, and then run the
initialize command. (Alternatively, run the reset command with the -i option.)
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Run Taxonomy Manager

To run the XBRL Taxonomy Manager, do one of the following:
·
·

·

In the EBA ribbon, click Manage Taxonomies.
Run (double-click) a file with .altova_taxonomies extension downloaded from the Altova website. To
open the XBRL Taxonomy Download Center in your browser, select the EBA ribbon, and then click
Altova on the Web > Taxonomy Download.
From the Windows Control Panel, right-click the Altova Taxonomy Manager entry and select
Change or Uninstall from the context menu.

In addition, the check box Invoke Altova Taxonomy Manager is available on the last page of the installation
wizard, after you complete the installation of Altova® European Banking Authority (EBA) XBRL add-in for Excel.

Command line interface
To run XBRL Taxonomy Manager from a command line interface:
1.
2.

Open a command prompt window and change directory to C:
\ProgramData\Altova\SharedBetweenVersions.
To display help at the command line, run:
TaxonomyManager.exe --help
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Install a Taxonomy

To install a taxonomy:
1.
2.

Run 39 XBRL Taxonomy Manager.
Select the check box next to the taxonomies or taxonomy versions you want to install, and click
Apply.

Alternatively, if you have downloaded a file with .altova_taxonomies extension from the Altova website
(https://www.altova.com/taxonomy-manager), double-click the .altova_taxonomies file to run it. XBRL
Taxonomy Manager opens when you run the .altova_taxonomies file.
Note the following:
·
·
·

Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect for all users accounts
on the same computer.
Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect in all Altova XBRLenabled applications installed on the same computer.
If the current taxonomy has dependencies on other taxonomies, the dependent taxonomies are also
installed (or uninstalled, as applicable).

Command line interface
To install a taxonomy, run:
TaxonomyManager.exe install FILTER...

Where FILTER means one of the following:
1.
2.

A taxonomy identifier in the format <name>-<version>, for example: eba-2.10, us-gaap-2020.0. To
view all the available taxonomy identifiers and versions, run the list command.
An .altova_taxonomies file downloaded from the Altova website.

Installing taxonomies on demand
Whenever XBRL taxonomies required by the add-in are missing from your computer, you may be prompted to
install taxonomies on demand. For example, a dialog box such as the one below may appear when you run an
action that requires loading XBRL taxonomies:
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When you click Yes, the missing taxonomies will be installed and the local cache directory will be updated to
keep track of this information. You can always view all of the previously installed taxonomies by clicking the
Manage Taxonomies button in the EBA ribbon.
If you select No, the missing taxonomies will not be installed, but you will not be able to use the add-in in this
case.
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Apply Patches

Occasionally, XBRL taxonomies may receive patches from their issuers. When the XBRL Taxonomy Manager
detects that patches are available, the following happens:
·
·

If you use XBRL Taxonomy Manager through the Windows graphical user interface, the respective
XBRL taxonomies are shown with the
icon.
If you use the command line or a Linux/macOS system, any XBRL taxonomies that have patches are
listed when you run the executable with the list -u command.

To apply a patch on Windows:
1.

Click the Patch Selection button. The icon of each XBRL taxonomy that qualifies changes from
, and the dialog box informs you about the patches that are to be applied, for example:
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The Patch Selection button is enabled only when there are patches available for any of the currently
installed XBRL taxonomies.
Click Apply.

To apply a patch at the command line interface:
1.
2.

Run the list -u command. This lists any taxonomies where patch upgrades are available.
Run the upgrade command to install the patches.

For more information, see the reference to the Command Line Interface
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View Installed Taxonomies

View Installed Taxonomies

To view all installed taxonomies from a graphical user interface, run 39 XBRL Taxonomy Manager. A selected
check box next to a taxonomy (or a taxonomy version) indicates that that taxonomy is installed.

Command line interface
To view all available taxonomies from a command line interface, run:
TaxonomyManager.exe list

To view only installed taxonomies, run:
TaxonomyManager.exe list -i

To view only taxonomies where a newer version is available, run:
TaxonomyManager.exe list -u
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Uninstall a Taxonomy

To uninstall a taxonomy:
1.
2.

Run 39 XBRL Taxonomy Manager.
Clear the check box next to the taxonomies or taxonomy versions you want to uninstall. If the selected
taxonomy is dependent on other taxonomy packages, a dialog box opens, informing you that the
dependencies will be removed as well, for example:

3.

Click Apply to remove the taxonomy and its dependencies.

Note the following:
·
·
·

Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect for all users accounts
on the same computer.
Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect in all Altova XBRLenabled applications installed on the same computer.
If the current taxonomy has dependencies on other taxonomies, the dependent taxonomies are also
installed (or uninstalled, as applicable).

Command line interface
To uninstall a taxonomy, run:
TaxonomyManager.exe uninstall FILTER...

Where FILTER means one of the following:
1.
2.

A taxonomy identifier in the format <name>-<version>, for example: eba-2.10, us-gaap-2020.0. To
view all the available taxonomy identifiers and versions, run the list command.
An .altova_taxonomies file downloaded from the Altova website.
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Command Line Interface

To call XBRL Taxonomy Manager at the command line, you need to know the path of the executable. By
default, the XBRL Taxonomy Manager executable is installed at the following path:
Linux*

/opt/Altova/<%APPNAME-UL%>2021/bin/taxonomymanager

macOS*

/usr/local/Altova/<%APPNAME-UL%>2021/bin/taxonomymanager

Windows

C:\ProgramData\Altova\SharedBetweenVersions\TaxonomyManager.exe

* The Linux and macOS paths are applicable only if you are running XBRL Taxonomy Manager on those
operating systems in conjunction with Altova cross-platform server applications such as MapForce Server,
StyleVision Server, or RaptorXML+XBRL Server.

By convention, this documentation omits the full path of the executable when describing a given command, and
uses <exec> instead of the executable name, for example:
<exec> help

Where <exec> is the path or name of the executable.

Calling XBRL Taxonomy Manager from the installation directory
To call the executable without having to type the full path, change the current directory to the one below:
Linux

cd /opt/Altova/<%APPNAME-UL%>2021/bin

macOS

cd /usr/local/Altova/<%APPNAME-UL%>2021/bin

Windows

cd "C:\ProgramData\Altova\SharedBetweenVersions"

You can now run a command by calling the executable with a relative path, for example:
Linux

sudo ./taxonomymanager help

macOS

sudo ./taxonomymanager help

Windows

TaxonomyManager.exe help

Note:

On Linux and macOS systems, the prefix ./ indicates that the executable is in the current directory.
The prefix sudo indicates that the command must be run with root privileges.

Calling XBRL Taxonomy Manager from any directory
To call the executable from any directory, refer to it using the absolute path. Alternatively, if you want to call the
program by typing just the executable name, you can edit the PATH environment variable of your operating
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system so that it includes the full path to the executable's directory. For ways to change the PATH
environment variable, refer to the documentation of your operating system.
Notes:
·
·

After changing the PATH environment variable, you may need to close the terminal window and open a
new one, in order for the changes to take effect.
On Linux and macOS, using sudo does not take into account the user's PATH.

Command line syntax
The general syntax for using the command line is as follows:
<exec> -h | --help | --version | <command> [options] [arguments]

In the listing above, the vertical bar | separates a set of mutually exclusive items. The square brackets []
indicate optional items. Essentially, you can type the executable path followed by either --h, --help, or -version options, or by a command. Each command may have options and arguments. The list of commands
is described in the following sections.

4.6.1

help

This command provides contextual help about commands pertaining to XBRL Taxonomy Manager executable.

Syntax
<exec> help [command]

Where [command] is an optional argument which specifies any valid command name.

Remarks
You can also invoke help by typing a command followed by -h or --help, for example:
<exec> list -h

You can also invoke general help by typing -h or --help directly after the executable, for example:
<exec> --help

Example
The following command displays help about the list command:
Linux, macOS

./taxonomymanager help list

Windows

TaxonomyManager.exe help list
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initialize

This command initializes XBRL Taxonomy Manager environment. It creates a cache directory where information
about all taxonomies is stored. Initialization is performed automatically the first time when you install an Altova
application that includes supports for XBRL Taxonomy Manager, so you don't need to run this command under
normal circumstances. You typically need to run this command after executing the reset command.

Syntax
<exec> initialize [options]

The alias of this command is init.

Options
--help, --h

Display help about this command at the command line.

--silent, --s

Display only error messages. The default value is false.

--verbose, --v

Display more information during execution. The default value is false.

4.6.3

install

This command installs one or more taxonomies. Note the following:
·
·
·

Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect for all users accounts
on the same computer.
Installing or uninstalling a taxonomy from XBRL Taxonomy Manager takes effect in all Altova XBRLenabled applications installed on the same computer.
If the current taxonomy has dependencies on other taxonomies, the dependent taxonomies are also
installed (or uninstalled, as applicable).

Syntax
<exec> install [options] FILTER...

To specify multiple taxonomies to install, repeat FILTER as many times as necessary.

Arguments
FILTER

Where FILTER means one of the following:
1.

2.

A taxonomy identifier in the format <name>-<version>, for example:
eba-2.10, us-gaap-2020.0. To view all the available taxonomy
identifiers and versions, run the list command.
An .altova_taxonomies file downloaded from the Altova website.
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You can also use abbreviated identifiers if they are unique, for example, eba. If
you use an abbreviated identifier, this will install the latest available version of
that taxonomy.

Options
--help, --h

Display help about this command at the command line.

--silent, --s

Display only error messages. The default value is false.

--verbose, --v

Display more information during execution. The default value is false.

Example
The following command installs the latest eba (European Banking Authority) and us-gaap (US Generally
Accepted Accounting Principles) taxonomies:
Linux, macOS

./taxonomymanager install eba us-gaap

Windows

TaxonomyManager.exe install eba us-gaap

4.6.4

list

Use this command to list taxonomies at the command line, in one of the following ways:
·
·
·
·

list
list
list
list

all available taxonomies
specific taxonomies
only installed taxonomies
only taxonomies that require upgrade.

Syntax
<exec> list [options] [FILTER...]

This command can be abbreviated with ls.

Arguments
FILTER

List only taxonomies that contain this string in their name. You can specify
this argument multiple times.

Options
--help, --h

Display help about this command at the command line.

--installed, --i

List only installed taxonomies. The default value is false.
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List only taxonomies where patch upgrades are available. The default value is
false.

--upgradeable, --u

Examples
To list all available taxonomies, run:
Linux, macOS

./taxonomymanager list

Windows

TaxonomyManager.exe list

To list only installed taxonomies, run:
Linux, macOS

./taxonomymanager list -i

Windows

TaxonomyManager.exe list -i

To list all taxonomies that contain either "eba" or "us-gaap" in their name, run:
Linux, macOS

./taxonomymanager list eba us-gaap

Windows

TaxonomyManager.exe list eba us-gaap

4.6.5

reset

This command removes all installed taxonomies and the cache directory.

Warning: This command deletes all installed taxonomies and their information.

After running this command, make sure to run the initialize command, in order to recreate the cache
directory. Alternatively, run the reset command with the -i option.
Note that reset -i restores the original installation of the product, so it's recommended to run the update
command as well, after performing a reset. Alternatively, run the reset command with the -i and -u options.

Syntax
<exec> reset [options]

Options
--help, --h

Display help about this command at the command line.

--init, --i

Initialize the XBRL Taxonomy Manager environment after reset. Valid values are
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true and false. The default value is false.
--silent, --s

Display only error messages. The default value is false.

--update, --u

Initialize and update the XBRL Taxonomy Manager environment after reset.
Valid values are true and false. The default value is false.

--verbose, --v

Display additional information during execution. The default value is false.

Examples
To reset the XBRL Taxonomy Manager, run:
Linux, macOS

./taxonomymanager reset

Windows

TaxonomyManager.exe reset

4.6.6

setdeflang

This command sets the language of XBRL Taxonomy Manager.

Syntax
<exec> setdeflang language

Where language is a mandatory argument supplying the language code. The alias of this command is sdl.

Arguments
The language to be set. Valid values are English (en), French (fr), German
(de), Japanese (ja), and Spanish (es).

language

Options
Display help about this command at the command line.

--help, --h

Examples
To set the language to Spanish, run:
Linux, macOS

./taxonomymanager setdeflang es

Windows

TaxonomyManager.exe setdeflang es
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uninstall

This command uninstalls one or more taxonomies. By default, any taxonomies referenced by the current one
are uninstalled as well. To uninstall just the current taxonomy and keep the referenced taxonomies, set the
option --k.

Syntax
<exec> uninstall FILTER...

To specify multiple taxonomies, repeat FILTER as many times as necessary.

Arguments
Where FILTER means one of the following:

FILTER

1.

2.

A taxonomy identifier in the format <name>-<version>, for example:
eba-2.10, us-gaap-2020.0. To view all the available taxonomy
identifiers and versions, run the list command.
An .altova_taxonomies file downloaded from the Altova website.

Options
--help, --h

Display help about this command at the command line.

--keep-references, --k

If this option is set, then referenced taxonomies are not uninstalled. The default
value is false.

--silent, --s

Display only error messages. The default value is false.

--verbose, --v

Display additional information during execution. The default value is false.

Example
The following command uninstalls the eba-2.10 and us-gaap-2020.0 taxonomies and their dependencies:
Linux, macOS

./taxonomymanager uninstall eba-2.10 us-gaap-2020.0

Windows

TaxonomyManager.exe uninstall eba-2.10 us-gaap-2020.0

4.6.8

update

This command queries the list of taxonomies available from the online storage and updates the local cache
directory. The update of this information takes place implicitly and you shouldn't need to run this command
unless you have performed a reset and initialize.
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Syntax
<exec> update [options]

Options
--help, --h

Display help about this command at the command line.

--silent, --s

Display only error messages. The default value is false.

--verbose, --v

Display additional information during execution. The default value is false.

Example
The following command updates the taxonomies information explicitly.
Linux, macOS

./taxonomymanager update

Windows

TaxonomyManager.exe update

4.6.9

upgrade

This command upgrades all eligible taxonomies to the latest available patch version. In other words, it performs
only upgrades at patch level of a specific release. Running this command is meaningful only if there are
upgradeable taxonomies available. You can identify upgradeable taxonomies by running the list -u
command.

Syntax
<exec> upgrade [options]

Options
--help, --h

Display help about this command at the command line.

--silent, --s

Display only error messages. The default value is false.

--verbose, --v

Display additional information during execution. The default value is false.
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Command Reference

The add-in commands available in the EBA tab of the Excel ribbon are listed below.

Insert New Report
Creates a new EBA filing report, see Creating a New Report
has already been inserted into the workbook.

11

. This command is disabled if the report sheet

Import from XBRL
Imports an XBRL instance file into the current Excel spreadsheet (see Importing Data from XBRL 33 ). This
command is disabled if a report has already been inserted into the workbook. To enable the command, save
and close the current report (workbook), and create a new workbook.

Export to XBRL
Exports data from all currently active sheets to an XBRL instance file (see Exporting Data to XBRL

32

).

Validate
Performs a validation of report data against the underlying XBRL taxonomy and displays the validation results in
a dialog box (see Validating Data 29 ).

Toggle EBA Filing Pane
Toggles the EBA Filing Pane on or off. By default, this pane is visible.

Toggle Validation Report
Shows or hides the "Validation Report" window, see Validating Data

29

.

Add Sheet (z-Axis)
Adds a new sheet which provides the ability to enter data in a third dimension. This button is enabled only if the
table supports a third dimension according to XBRL taxonomy. For more information, see Entering Data into
Three-Dimensional Tables (Z-Axis) 22 .

Remove Sheet (z-Axis)
Removes a previously added Z-axis sheet.

Add Row
Adds a new row to the currently selected table. This button is enabled only if the table supports growing
vertically.

Delete Row
Deletes an existing row. This button is enabled only if the table supports growing vertically.
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Add Column
Adds a new column to the currently selected table. This button is enabled only if the table supports growing
horizontally.

Delete Column
Removes an existing column. This button is enabled only if the table supports growing horizontally.

Manage Taxonomies
This command opens the XBRL Taxonomy Manager tool, from where you can view, install, and uninstall XBRL
taxonomies. See Managing XBRL Taxonomies 35 .

Settings
Displays a dialog box where you can view or change the add-in settings

56

.

Help
Opens this help file, in CHM (Microsoft Compiled HTML Help) format.

Add-In Activation
Displays the activation status of the add-in, or provides options to enter or purchase a license key code.

About EBA Add-In
Displays version information about the add-in.

Altova on the Web
Provides links to the Altova website (including Online Support Center, XBRL Taxonomy Download Center,
training and tutorials).
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Settings

To view or change the add-in settings:
1.
2.

In the Excel ribbon, click the EBA tab.
Click Settings.

The settings you can configure are listed below.

Instance Creation
Add 'generated by' comment

Specifies if the exported XBRL instances should contain a
"Generated by..." comment. Set this option to false if your
reporting authority doesn't permit comments in the created
reports. The default value is true.

Create streamable XBRL

Specifies if the exported XBRL instances should be
streamable and contain the xbrl-streamable-instance
processing instruction. Set this option to false if your
reporting authority doesn't permit processing instructions in
the created reports. The default value is true.

Treat invalid cell values as

Specifies whether invalid cell values should be treated as
validation errors or warnings. The default value is "Error".

Treat missing Identifier as

After you create a new report, the EBA Filing Pane
contains a property called Identifier which is by default
empty. This option specifies whether an empty Identifier
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property should trigger a validation error or a warning. The
default value is "Error".

Misc
Preferred Label Language

Specifies the preferred language to be used in the headers of
created worksheets. Note that the respective label resources
must be defined in the taxonomy for this setting to take
effect. The default value is "en".

Validation
EBA XBRL Filing Rules

© 2015-2021 Altova Gmb H

Specifies if the additional EBA XBRL filing rules (as specified
by the "EBA XBRL Filing Rules" document) should be
checked. The default value is "Enabled".
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License Information

This section contains information about:
·
·
·

the distribution of this software product
software activation and license metering
the license agreement governing the use of this product

Please read this information carefully. It is binding upon you since you agreed to these terms when you
installed this software product.
To view the terms of any Altova license, go to the Altova Legal Information page at the Altova website.
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